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Information Technology for Class IX-Set 1 

Time : 2 Hrs         Max. Marks : 50 

General Instructions 

• Please read the instructions carefully. 

• This Question paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions, whereas Section B contains Subjective 

Type Questions. 

• Out of the given (5+16)=21 questions, a candidate has to answer (5+10)=15 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• There is no negative marking. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

• Section B Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

Section A Objective Type Questions 

1. Answer any 4 out of the given 6 questions on Employability Skills:  (1×4=4) 

(i) During a group discussion, Anil uses difficult vocabulary and technical terms that others 

don’t understand. What barrier is this? 

(a) Physical barrier 

(b) Semantic barrier 

(c) Psychological barrier 

(d) Feedback barrier 

 

(ii) Amit fails in a test but sets a new goal to improve in the next exam. This shows: 

(a) Lack of motivation 

(b) Time-wasting habit 

(c) Positive attitude and goal setting 

(d) Disinterest in studies 

 

(iii) Which of the following statements about positive thinking is correct? 

(a) Positive thinking results in positive circumstances. 

(b) Positive thinking helps in focusing on the bright side of an individual’s life. 

(c) Positive people can easily overcome problems and achieve success. 

(d) All of the above 

 

(iv) To connect to the Internet, the computer has to be connected to the 

(a) Internet Society 

(b) Internet Architecture 

(c) Internet Service Provider 

(d) Large Area Network 
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(v) Product and services both are sold in 

(a) Product business 

(b) Service business 

(c) Hybrid business 

(d) General business 

(vi) Which of the following is a biodegradable pollutant? 

(a) Lead 

(b) Plastic 

(c) Cattle dung 

(d) Insecticide 

 

2. Answer any 5 out of the given 6 questions:      (1×5=5) 

(i) Ravi is hired by a company to handle customer queries and billing through emails and 

calls. Which sector is he working in? 

(a) IT Services 

(b) BPM (Business Process Management) 

(c) Data Analytics 

(d) Hardware Maintenance 

 

(ii) Business organizations uses computers for ………. 

(a) Financial forecasting 

(b) Payroll calculation 

(c) Sales analysis 

(d) All of the above 

 

(iii) Which of the following best demonstrates the use of large-scale computer applications in 

the airline industry? 

(a) Monitoring weather conditions 

(b) Managing reservations at airports and call-centers 

(c) Broadcasting airline advertisements 

(d) Designing new aircraft models 

 

(iv) Which of the following machines is used to monitor the heartbeat? 

(a) Electrocardiogram Machine 

(b) Cardiac Screening Machine 

(c) Computerised Axial Tomography Machine 

(d) Magnetic Resonance Imaging Machine 

 

(v) Bank customers uses ATM machines for ………. 

(a) Deposit cash 

(b) Withdraw cash 

(c) View balance 

(d) All of the above 

 

(vi) You want to add a pre-designed image from the Gallery into your presentation in 

Impress. Which menu path should you follow? 

(a) Insert → Media → Gallery 

(b) Insert → Picture → From File 
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(c) Format → Slide Layout → Add Image 

(d) Tools → Options → Add Image 

 

3. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) The left index finger is reserved for all the 

(a) green keys 

(b) red keys 

(c) blue keys 

(d) orange keys 

 

(ii) Which keys are known as the home keys on the keyboard? 

(a) ASDF 

(b) LKJ 

(c) QWER 

(d) Both (a) and (b) 

 

(iii) Which of the following is not a pointing device? 

(a) Mouse 

(b) Light pen 

(c) Monitor 

(d) Trackball 

 

(iv) Which of the following is a Free and Open Source Software designed to learn typing 

skills? 

(a) Microsoft word 

(b) LibreOffice writer 

(c) Rapid Typing Tutor 

(d) All of the above 

 

(v) What is the full form of KPM? 

(a) Keys per minute 

(b) Keystrokes per minute 

(c) Key per meter 

(d) None of these 

 

(vi) While organizing a presentation with multiple slides named by default (e.g., Slide1, 

Slide2…), what should you do to make slide management and navigation clearer, especially 

in outline or slide sorter view? 

(a) Add slide numbers in the footer 

(b) Change slide layout to Title and Content 

(c) Insert a table of contents slide at the beginning 

(d) Rename each slide with relevant titles reflecting their content 

 

4. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) Which of the following list is a listing order that is done with numbers? 

(a) Bullet list 

(b) Number list 
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(c) Order list 

(d) Both (b) and (c) 

 

(ii) In LibreOffice Writer, which menu allows you to define and apply your own styles for text, 

pages, or lists? 

(a) Format → Character 

(b) Tools → AutoCorrect 

(c) Styles →Manage Styles 

(d) Insert → Page Number 

 

(iii) To find a word in a document we can use which of the following function key? 

(a) F5 key 

(b) F8 key 

(c) F1 key 

(d) None of these 

 

(iv) The default orientation of a page in Writer is 

(a) portrait 

(b) landscape 

(c) book 

(d) None of these 

 

(v) The Cut, Copy and Paste commands are found in …………. 

(a) Shapes group of Home tab 

(b) Clipboard group of Home tab 

(c) Style group of Insert tab 

(d) None of these 

 

(vi) ……feature is used to build a new slide show which contains the same slides but in a 

different order. 

(a) Custom slide show 

(b) Slide show 

(c) Slide view 

(d) Rehearsal 

 

5. Answer any 5 out of the given 6 questions:      (1×5=5) 

(i) The cell labeled F5 refers to 

(a) row F column 6 

(b) column F row 5 

(c) function available in cells 

(d) function key F5 

 

(ii) Which of the following chart selects only one range of the data series? 

(a) Line chart 

(b) Pie chart 

(c) Scatter chart 

(d) Bar chart 
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(iii) =COUNTA (4, 78, False , 18) will return …………… 

(a) 2 

(b) 3 

(c) 4 

(d) 5 

 

(iv) While entering a formula, cell address B5 represents 

(a) Absolute Referencing 

(b) Mixed Referencing 

(c) Relative Referencing 

(d) All of these 
 

(v) Goal seek option is available in which of the following menus in spreadsheet? 

(a) Format 

(b) Edit 

(c) Tools 

(d) Insert 
 

(vi) What is the step to save the presentation as HTML? 

(a) File → Export 

(b) File → Export as PDF 

(c) Edit → Export 

(d) None of the above 
 

Section B: Subjective Type Questions 

Answer any 3 out of the given 5 questions on Employability Skills in 20-30 words 

each.            (2×3=6) 

6. Who is an effective speaker? 

7. How do we identify our weakness? 

8. What characters should the password have in E-mail address, to make it more secure? 

9. What are the three types of business activities? Explain with examples? 

10. What are the five sources of energy available to us? Give one example of each source? 

 

Answer any 4 out of the given 6 questions in 20-30 words each:   (2×4=8) 

11. What are the various processes of education where IT is used? 

12. What do you understand by scrolling? 

13. List the various components of Libre Office suite, Explain each component in one line. 

14. Write the steps to insert and delete the worksheet in Calc. 

15. What do you mean by relative referencing? 

16. What are the advantages of using a presentation? 

 

Answer any 3 out of the given 5 questions in 50-80 words.    (4×3=12) 

17. What is IT-BPM industry? Also, write some advantages for which BPO services industry 

is doing exceptionally well in India. 

18. How can you view and analyse statistics? 

19. Write the steps to print the Writer document. 

20. What are the different types of data that can be entered in Calc? 

21. How will you format the text in Impress presentation?  
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Information Technology for Class IX-Set 2 

Time : 2 Hrs         Max. Marks : 50 

General Instructions 

• Please read the instructions carefully. 

• This Question paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions, whereas Section B contains Subjective 

Type Questions. 

• Out of the given (5+16)=21 questions, a candidate has to answer (5+10)=15 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• There is no negative marking. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

• Section B Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

Section A Objective Type Questions 

1. Answer any 4 out of the given 6 questions on Employability Skills.  (1×4=4) 

(i) Ananya is presenting a project in class. Her voice is clear, but she doesn’t make eye 

contact with anyone. Which part of communication is she missing? 

(a) Verbal communication 

(b) Listening skills 

(c) Non-verbal communication 

(d) Written communication 

 

(ii) Which of the following is a quality of a self-confident person? 

(a) Patient 

(b) Compassionate 

(c) Committed 

(d) Passionate 

 

(iii) Aman wants to study for exams but keeps getting distracted by his phone. What should 

he do to manage time better? 

(a) Learn multitasking 

(b) Avoid studying 

(c) Make a daily timetable and follow it 

(d) Sleep for 8 hours 

 

(iv) What is the term used when you press and hold the left mouse key and move the mouse 

around? 

(a) Highlighting 

(b) Dragging 

(c) Selecting 
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(d) Moving 

 

(v) An entrepreneur is developing a new product. Instead of sticking to one method, she 

keeps experimenting with different ideas to find the most effective solution. Which 

entrepreneurial quality is she demonstrating? 

(a) perseverance 

(b) confidence 

(c) trial and error 

(d) creativity 

 

(vi) Rita is studying how forests support human life in different ways. She learns that forests 

not only provide wood for furniture and fuel but also offer items like honey, spices, and 

medicines. Which of the following best describes the importance of forest resources? 

(a) Forests are used only for timber and firewood. 

(b) Forests are mainly recreational spaces for humans. 

(c) Forests provide a wide range of products and services essential to human life. 

(d) Forests are useful only for animal habitat. 

 

2. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) A company uses online chatbots to handle customer queries 24×7. This shows the role of 

IT in: 

(a) Reducing communication 

(b) Improving entertainment 

(c) Enhancing customer service 

(d) Blocking user feedback 

 

(ii) What is Information Technology (IT) primarily concerned with? 

(a) Creating, managing, storing and exchanging information. 

(b) Developing hardware for digital devices. 

(c) Manufacturing mobile devices 

(d) Teaching programming languages 

 

(iii) A citizen files a complaint about garbage collection using a mobile app provided by the 

municipality. This is an example of: 

(a) Online education 

(b) e-Governance 

(c) Online marketing 

(d) Social networking 

 

(iv) ATM (Automated Teller Machine) is example of ………… 

(a) IT in insurance 

(b) IT in banking 

(c) IT in education 

(d) IT in healthcare 

 

(v) In healthcare computerized machines are used to ………… 

(a) Record heart activity 
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(b) Record brain activity 

(c) Capture X- rays 

(d) All of the above 

 

(vi) During a class presentation, Aisha adds images from her computer to make her slides 

more informative and engaging. What is the main purpose of inserting graphics in a 

presentation? 

(a) To make the slides colorful 

(b) To avoid writing text 

(c) To provide more information visually 

(d) To replace spoken content 

 

3. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) Which of the following stage of touch typing technique involves memorising frequently 

used syllables and typing words containing these syllables? 

(a) Stage one 

(b) Stage three 

(c) Stage two 

(d) None of these 

 

(ii) In which of the following factor, you should not cross your legs? 

(a) Position of hands 

(b) Sitting posture 

(c) Monitor placement 

(d) Mouse and keyboard placement 

 

(iii) In which year did Xerox introduce an electronic typewriter to address the limitations of 

manual typewriters? 

(a) 1964 

(b) 1974 

(c) 1984 

(d) 1994 

 

(iv) Which letters we type with our left hand? 

(a) asdfxe 

(b) asdlk 

(c) qwerty 

(d) jkl 

 

(v) Keys which guides for typing are known as ……….. 

(a) Arrow keys 

(b) Cursor keys 

(c) Enter keys 

(d) Numeric keys 

 

(vi) We can insert text box in Impress presentation by ……….. keyboard shortcut key, 

(a) F1 
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(b) F5 

(c) F2 

(d) F12 

 

4. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) Saving an existing document with some other name using the Save As option………… 

(a) replaces the current document 

(b) leaves the current document intact 

(c) is not possible 

(d) closes the document 

 

(ii) To hide or view ruler we should go to which of the following menus? 

(a) Tools Menu 

(b) Insert Menu 

(c) View Menu 

(d) Edit Menu 

 

(iii) Which of the following technique selects a sentence in Writer? 

(a) Single click (Pressing left button of mouse) 

(b) Double click 

(c) Triple click 

(d) None of the above 

 

(iv) It shows the name of the currently opened document 

(a) Title bar 

(b) Task bar 

(c) Status bar 

(d) Menu bar 

 

(v) In ……….. page orientation height of the page is less than its width. 

(a) portrait 

(b) Landscape 

(c) A4 

(d) Legal 

 

(vi) Which of the following is not a part of main impress window? 

(a) Work pane 

(b) Slides pane 

(c) Workspace 

(d) Task pane 

 

5. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) Which of the following shortcut keys brings the cursor to the last cell on the sheet that 

contains data? 

(a) Ctrl + Home 

(b) Ctrl+ End 

(c) Ctrl+ Page down 
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(d) Ctrl+ down arrow 

 

(ii) A Cell range starting from first row, first column to fourth row and fifth column can be 

represented as 

(a) [A1: E4] 

(b) [A0: E3] 

(c) [E4 : A1] 

(d) [E 3: A0] 

 

(iii) The default page orientation in Calc is 

(a) Landscape 

(b) Horizontal 

(c) Portrait 

(d) None of these 

 

(iv) How can we enter a formula in Calc? 

(a) Using function wizard or selecting from toolbar 

(b) Directly typing function name in a cell 

(c) Both (a) and (b) 

(d) None of the above 

 

(v) Which of the following is the correct option to print a chart in Calc? 

(a) Home → chart 

(b) Insert → print chart 

(c) View → chart 

(d) File → print 

 

(vi) ………….. option helps to create animation in drawings, images, text etc. 

(a) Slide transition 

(b) Custom animation 

(c) Insert animation 

(d) Drawing tools 

 

Section B: Subjective Type Questions 

Answer any 3 out of the given 5 questions on Employability skills in 20-30 words 

each.            (2×3=6) 

6. State any two advantages and two disadvantages of verbal communication. 

7. What is self-confidence? Suggest any two qualities of a self-confident person. 

8. What do you mean by tablet? 

9. What are the key differences between entrepreneurship and enterprise? 

10. Describe any three methods of water conservation. 

 

Answer any 4 questions out of the given 6 questions in 20-30 words each.  (2×4=8) 

11. What do you mean by BPO services ? 

12. What are the base positions of your fingers on keyboard? 
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13. How will you count the total words of a document? 

14. What is the default name of the worksheet? How can it be renamed? 

15. Write down the significance of electronic spreadsheets. 

16. How will you open LibreOffice Impress in Ubuntu Linux? 

 

Answer any 3 out of the given 5 questions in 50-80 words each:   (4×3=12) 

17. Describe the uses of IT in government and public service. 

18. Explain the steps to start the touch typing lesson. 

19. How can you insert rows and columns in the table in Writer? 

20. What are the different types of charts available in Calc? 

21. Write the steps to insert duplicate slide in a presentation. 
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Information Technology for Class IX-Set 3 

Time : 2 Hrs         Max. Marks : 50 

General Instructions 

• Please read the instructions carefully. 

• This Question paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions, whereas Section B contains Subjective 

Type Questions. 

• Out of the given (5+16)=21 questions, a candidate has to answer (5+10)=15 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• There is no negative marking. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

• Section B Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

Section A Objective Type Questions 

1. Answer any 4 out of the given 6 questions on Employability skills.   (1×4=4) 

(i) Which of the following options best represents oral communication, and how does it allow 

for immediate feedback between participants? 

(a) Reports 

(b) Newspapers 

(c) Face-to-face conversation 

(d) Notes 

 

(ii) Do you think people living in hill stations can skip taking a bath for many days? 

(a) No, irrespective of the climate, one should take a bath regularly. 

(b) Yes, not taking bath for many days is acceptable for people staying in cold climate. 

(c) Yes, if they wipe themselves with a wet cloth, then it is fine. 

(d) None of the above 

 

(iii) Rahul notices that his friend always interrupts while he’s speaking in group discussions. 

Rahul feels angry but wants to handle the situation maturely. Which two self-management 

skills should he combine to resolve this calmly? 

(a) Self-control and positive attitude 

(b) Overthinking and ignoring 

(c) Laziness and avoidance 

(d) Blaming and arguing 

 

(iv) There is a talent contest in your town. For participating in the audition, you have to send 

a recording of a song. What would you connect to your computer to record your song. 

(a) Keyboard 

(b) Microphone 
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(c) Scanner 

(d) Mouse 

 

(v) Creation of more jobs by entrepreneur is 

(a) Economic development 

(b) Social development 

(c) Living standard development 

(d) Service development 

 

(vi) How can energy be generated from biomass, and in what ways can this energy be used 

in daily life? 

(a) By using windmills; used only for lighting 

(b) By burning fossil fuels; used for running vehicles 

(c) By using plant and animal waste; used for cooking and electricity generation 

(d) D. By using solar panels; used only during daytime 

 

2. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) What is the full form of MRI ? 

(a) Magnetic Resource Imaging 

(b) Magnetic Resonance Imaging 

(c) Magnetic Resource Image 

(d) Magnetic Resonance Image 

 

(ii) A start-up wants to expand its customer base by combining online ads, social media, 

and24 \times 7support. Which ITES services are used here? 

(a) e-Governance and CAD 

(b) e-Commerce and Call Center 

(c) Medical Transcription and Data Entry 

(d) Animation and CAD 

 

(iii) …………. machine is used to record the activities of the brain? 

(a) EEG 

(b) ECG 

(c) MRI 

(d) CAT 

 

(iv) ITeS is also called ………… 

(a) remote services 

(b) Web-enabled services 

(c) Internet services 

(d) Both (a) and (b) 

 

(v) We can save ……….. in our computers. 

(a) List of contacts 

(b) Important documents 

(c) pictures 

(d) All of these 
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(vi) Which of the following menu is used to add objects like tables, shapes, textbox and 

charts into a presentation? 

(a) Edit menu 

(b) Home menu 

(c) Insert menu 

(d) page layout menu 

 

3. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) Which key is used to enable and disable the numeric keypad? 

(a) Windows key 

(b) Num lock key 

(c) Shift key 

(d) Ctrl key 

 

(ii) Which of the following operation is not performed by a mouse? 

(a) Left click 

(b) Right click 

(c) Middle click 

(d) Double click 

 

(iii) How many shift keys are there on a keyboard? 

(a) 2 

(b) 4 

(c) 1 

(d) 3 

 

(iv) Out of ‘Q’, ‘W’, ‘E’, ‘R’, ‘T’ keys, which two keys are pressed by same finger? 

(a) ‘T ‘ and ‘R’ 

(b) ‘E’ and ‘R’ 

(c) ‘W’ and ‘E’ 

(d) ‘Q’ and ‘W’ 

 

(v) Numeric keypad is normally located on which side of keyboard? 

(a) Left 

(b) Right 

(c) Top 

(d) None of these 

 

(vi) We can insert new slide in impress by …………. 

(a) Ctrl+M 

(b) Slide →New Slide 

(c) Both (a) and (b) 

(d) None of these 

 

4. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) Which of the following should be used to move a paragraph from one place to another in a 

writer document? 
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(a) Copy and paste 

(b) Cut and paste 

(c) Delete and retype 

(d) Find & replace 

 

(ii) Which of the following does not come under page formatting? 

(a) Setting margins 

(b) Find & replace 

(c) Setting header and footer 

(d) Page orientation 

 

(iii) Which tab provides options for changing alignment? 

(a)View 

(b) Format 

(c) Preview 

(d) Page Layout 

 

(iv) Spellings are corrected automatically in Writer because of which of the following 

features? 

(a) AutoText 

(b) AutoCorrect 

(c) AutoComplete 

(d) All of these 

 

(v) Header and Footer option is available in which of the following menus? 

(a) File Menu 

(b) Insert Menu 

(c) View Menu 

(d) Edit Menu 

 

(vi) In Impress, what is the effect of holding the Ctrl key while dragging an object like a shape 

or image on a slide? 

(a) The object is deleted 

(b) The object is resized 

(c) A copy of the object is created and placed at the new location 

(d) The object is grouped with others 

 

5. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) A chart is created on the basis of values in 

(a) mail merge 

(b) database 

(c) spreadsheet 

(d) document 

 

(ii) If we move a cell containing a formula having reference to another cell in the worksheet 

what will happen to the cell numbers used in the formula? 

(a) The cell row and columns are changed at destination 
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(b) The cell row change at destination 

(c) The cell columns are changed at destination 

(d) No change will occur 

 

(iii) The simplest way to move data from one location to another in Calc is 

(a) by Quick Access toolbar 

(b) using Cut and Paste 

(c) by the drag and drop method 

(d) Both (b) and (c) 

 

(iv) Which of the following is an extension of a worksheet created in Calc? 

(a) .ods 

(b) .ocd 

(c) .xls 

(d) .obj 

 

(v) How many axes does charts in Calc have? 

(a) Two 

(b) Three 

(c) Two or three 

(d) Four 

 

(vi) By using ………… we can add notes to a slide. 

(a) Normal view 

(b) Outline view 

(c) Notes view 

(d) Slide sorter view 

 

Section B: Subjective Type Questions 

Answer any 3 out of the given 5 questions on Employability skills in 20-30 words 

each.            (2×3=6) 

6. State any two importance of communication skill. 

7. List any five self-management skills. 

8. Write the purpose of the I/O devices 

(a) Mic/Microphone 

(b) Scanner 

(c) Camera 

(d) Barcode Reader 

(e) Printer 

(f) Speaker 

 

9. What are the key differences between product and service-based businesses? 

10. What are green skills? 
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Answer any 4 out of the given 6 questions in 20-30 words each.   (2×4=8) 

11. Give examples of uses of IT in everyday life. 

12. Why the use of various typing software is common now-a-days? 

13. What are the various menus of Writer GUI? 

14. Give the syntax and example of any three string functions in spreadsheet. 

15. What is an active cell? How to delete the contents of an active cell? 

16. Write the procedure to delete the text of the slide? 

 

Answer any 3 out of the given 5 questions in 50-80 words each.   (4x=12) 

17. Define ICT. Also, give its advantages and disadvantages. 

18. Explain the various components of Rapid Typing window. 

19. Explain the different types of tabs available in LibreOffice Writer. 

20. Explain any five functions that can be used in a worksheet. 

21. Explain the copying and moving slides in detail. 
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Information Technology for Class IX-Set 4 

Time : 2 Hrs         Max. Marks : 50 

General Instructions 

• Please read the instructions carefully. 

• This Question paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions, whereas Section B contains Subjective 

Type Questions. 

• Out of the given (5+16)=21 questions, a candidate has to answer (5+10)=15 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• There is no negative marking. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

• Section B Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

Section A: Objective Type Questions [24 Marks] 

1. Answer any 4 out of the given 6 questions on Employability skills.   (1×4=4) 

(i) While having a conversation, how can you show that you are engaged and positively 

responding to the speaker through your facial expressions? 

(a) Staring hard 

(b) Nodding while listening 

(c) Wrinkled forehead 

(d) Looking away from the speaker 

 

(ii) You have a conflict with a classmate during a group project. How would you show self-

control in this situation? 

(a) Shout back 

(b) Listen calmly and discuss the issue 

(c) Leave the group 

(d) Complain to the teacher without trying to resolve it 

 

(iii) What is the best way to start our day positively? 

(a) Think about all that can go wrong. 

(b) Think about the difficult test you will face during the day. 

(c) Think about all your accomplishment so far and feel good about it. 

(d) Think about the traffic on the road and feel stressed. 

 

(iv) What happens if you leave a device plugged in even after it is charged 100% ? 

(a) It can overheat 

(b) Data can be lost 

(c) It can break 

(d) It can stop functioning 
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(v) What is the aim of entrepreneurship? 

(a) Earn a profit 

(b) Solve customer’s need innovatively 

(c) Both (a) and (b) 

(d) None of these 

 

(vi) Most of the energy we use today comes from fossil fuels. Based on your understanding 

of energy sources, which fundamental source is primarily responsible for this stored energy? 

(a) Gravity generated by the Earth and Moon 

(b) Nuclear fission reactions 

(c) Energy stored in chemical bonds 

(d) Nuclear fusion in the Sun. 

 

2. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) An NGO wants to spread awareness about cleanliness by uploading videos and live 

sessions on the internet so that people can access them anytime. Which IT-enabled service 

are they using? 

(a) e-Governance 

(b) e-Learning 

(c) e-Commerce 

(d) Data Entry 

 

(ii) Ravi is studying different types of firms operating in India and comes across a company 

that provides IT and support services to its parent company abroad. This company has its 

headquarters located in Bengaluru, India. Based on this information, what type of firm is it 

most likely to be? 

(a) MNC 

(b) GIC 

(c) ISP 

(d) None of these 

 

(iii) ……….. machine is used to give the digital impression of internal organs of the body. 

(a) MRI 

(b) ECG 

(c) CAD 

(d) CAT 

 

(iv) What is the full form of GDP? 

(a) Gross Domestic Product 

(b) Gross Digital Product 

(c) Gross Domain Product 

(d) None of these 

 

(v) Which organization belong to the IT-BPM industry? 

(a) Indian Service Provider 

(b) Global In-house Centers 

(c) Multinational Companies 
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(d) All of these 

 

(vi) During her oral exam, Neha wants to display her presentation without any toolbars or 

menus showing. Which option should she choose? 

(a) Normal view 

(b) Outline view 

(c) Slide Show mode 

(d) Master Slide view 

 

3. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) Which of the following buttons shows the elapsed time and remaining time when a user is 

working with a lesson? 

(a) Pause the lesson button 

(b) Current lesson time button 

(c) Time lesson button 

(d) None of these 

 

(ii) Which of the following mode of numeric keypad represents numbers? 

(a) Numeric mode 

(b) Cursor control mode 

(c) Both (a) and (b) 

(d) None of these 

 

(iii) Rahul’s typing speed is 30 WPM. What is the full form of WPM? 

(a) Words per minute 

(b) Words per meter 

(c) Words per master 

(d) None of these 

 

(iv) The numeric keypad is located on which side of a standard keyboard? 

(a) Left 

(b) Right 

(c) Top 

(d) Bottom 

 

(v) …………. keys from F1 to F12 have different meanings depending on the running 

program. 

(a) Arrow 

(b) Toggle 

(c) Function 

(d) Numeric 

 

(vi) Which of the following feature is used to progress the slide show automatically while 

speaking on the topic? 

(a) Custom Animation 

(b) Rehearse Timing 

(c) Slide Transition 
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(d) Either (a) or (b) 

 

4. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) The first tab of LibreOffice Writer is 

(a) File 

(b) View 

(c) Insert 

(d) Review 

 

(ii) In LibreOffice Writer, document has text case option which help to change the text case. 

They are 

(a) Sentence case 

(b) lowercase 

(c) UPPERCASE 

(d) All of these 

 

(iii) Which option should be used to type H2O to get 2 at its proper place? 

(a) Bold 

(b) Superscript 

(c) Underline 

(d) Subscript 

 

(iv) We can change the mistakes noticed in which of the following? 

(a) Electronic typewriter 

(b) Word processor software 

(c) Both (a) and (b) 

(d) Simple typewriter 

 

(v) The default table size is …………. 

(a) 1 column, 1 row 

(b) 2 columns, 1 row 

(c) 2 columns, 2 rows 

(d) 1 column, 2 rows 

 

(vi) Which Impress view display miniature version of slides arranged on the screen and is 

useful for record them and see more slides at one time? 

(a) Slide show 

(b) Slide master 

(c) Notes page 

(d) Slide sorter 
 

5. Answer any 5 out of the given 6 questions      (1×5=5) 

(i) While working with spreadsheets, in which directions can you use the AutoFill feature to 

quickly complete a series of data? 

(a) left to right 

(b) right to left 

(c) up to down 
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(d) All of these 

 

(ii) The chart preview can be seen in 

(a) Page preview 

(b) Chart preview 

(c) Export chart 

(d) All of these 

 

(iii) If cell range A1 : A5 contain the numbers 20,16,5,35 and 7 then = AVERAGE ( A1 : A5, 

50 ) will display. 

(a) 22.167 

(b) 27.167 

(c) 10 

(d) 40 

 

(iv) Which of the following charts is used for comparing the changes in data over a period of 

time? 

(a) Bar chart 

(b) Area chart 

(c) Scatter chart 

(d) Line chart 

 

(v) ……….. is the small black square in the bottom right corner of the selected cell. 

(a) Fill handle 

(b) Fill range 

(c) Fill comer 

(d) None of these 

 

(vi) Choose the correct steps to ungroup object in Libre Office impress. 

(a) Format → Ungroup 

(b) Format → Group → Ungroup 

(c) Insert → Object → Ungroup 

(d) None of these 

 

Section B: Subjective Type Questions 

Answer any 3 out of the given 5 questions on Employability skills in 20-30 words 

each.            (2×3=6) 

6. Which is your favourite festival? Write two paragraphs about your favourite festival. Each 

paragraph should have a minimum of four sentences. Make sure you follow all the rules 

about sentences and paragraphs you have learnt. 

7. What do you mean by positive thinking? Write about the importance of positive thinking. 

8. List any two important parts of a web browser. 

9. List any four characteristics of entrepreneurship. 

10. How education can help in saving the environment? 
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Answer any 4 out of the given 6 questions in 20-30 words each.   (2×4=8) 

11. List the various uses of IT in a banking system. 

12. What do you mean by keyboarding skills? 

13. Define the term Mail Merge 

14. Sana has entered 49+30 in a cell. The worksheet is not displaying 79 in the cell. Instead, 

49+30 is getting displayed. Help, Sana in rectifying the problem. 

15. Give the syntax and example of any three mathematical functions in spreadsheet. 

16. Explain the slide sorter view in brief. 

 

Answer any 3 out of the given 5 questions in 50-80 words each.   (4×3=12) 

17. What is the use of IT in entertainment? Explain. 

18. What is RapidTyping tutor? Write the steps to start the RapidTyping software. 

19. How to Find & Replace the text in Writer? 

20. Differentiate between mixed referencing and absolute referencing by giving suitable 

examples. 

21. What are the five views of Presentation? 
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Information Technology for Class IX-Set 5 

Time : 2 Hrs          Max. Marks : 50 

General Instructions 

• Please read the instructions carefully. 

• This Question paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions, whereas Section B contains Subjective 

Type Questions. 

• Out of the given (5+16)=21 questions, a candidate has to answer (5+10)=15 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• There is no negative marking. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

• Section B Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

Section A: Objective Type Questions 

1. Answer any 4 out of the given 6 questions on Employability skills.   (1×4=4) 

(i) Rahul is talking to his teacher but keeps looking at his phone and not listening carefully. 

What should he do to show good communication? 

(a) Keep using his phone while the teacher speaks 

(b) Maintain eye contact and listen actively 

(c) Interrupt the teacher with unrelated questions 

(d) Walk away without responding 

 

(ii) Priya feels nervous when speaking in front of her classmates. Which self-management 

skill can help her overcome this? 

(a) Self-confidence 

(b) Self-praise 

(c) Laziness 

(d) Overthinking 

 

(iii) Which of the following is a web browser? 

(a) Internet 

(b) Chrome 

(c) Windows 

(d) None of these 

 

(iv) Amit notices he always forgets to submit his homework on time. What should he do? 

(a) Keep forgetting because it doesn’t matter 

(b) Make a to-do list and use reminders 

(c) Copy others’ homework at the last minute 
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(d) Blame the teacher for giving homework 

 

(v) Entrepreneurship allows to start something according to 

(a) market 

(b) choice 

(c) need 

(d) innovation 

 

(vi) While planning sustainable development, why is it important to manage the use of 

mineral resources like iron, copper, salt, and gypsum wisely? 

(a) Because they are easily renewable 

(b) Because they are unlimited in nature 

(c) Because they are non-renewable and may get exhausted 

(d) Because they are not useful in daily life 

 

2. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) A student attends an online coding workshop from home using a laptop and internet. This 

is an example of: 

(a) Data processing 

(b) Online learning 

(c) Animation & graphics 

(d) Web designing 

 

(ii) Which of the following means creating, managing, storing and exchanging information? 

(a) IT 

(b) ITeS 

(c) BPO 

(d) KPO 

 

(iii) Information is translated into electric pulses in ……….. 

(a) Hybrid Technology 

(b) Analog Technology 

(c) Digital Technology 

(d) None of the above 

 

(iv) What are modern computers based on? 

(a) Microprocessors 

(b) Microchip 

(c) I/O Devices 

(d) Both (a) and (b) 

 

(v) Which of the following is not considered as an ICT device? 

(a) Smartphone 

(b) Laptop 

(c) Tablet 

(d) E-mail 
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(vi) While working in Impress, you notice two marked sections on the Zoom slider in the 

Status Bar. In which section should you position the slider to view the entire slide within the 

Workspace? What happens when you move it to the second marked section? 

(a) First – Full slide, Second – 100% zoom 

(b) First – Zoom out, Second – Fit to slide 

(c) First – Content only, Second – Slide hidden 

(d) First – Title only, Second – Full screen 

 

3. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) The keyboard learning process starts from 

(a) second row 

(b) fourth row 

(c) first row 

(d) third row 

 

(ii) In the RapidTyping tutor, which of the following is not true? 

(a) Green letters denote right inputs 

(b) Yellow letters stand for right inputs in extra time. 

(c) Red letters denote wrong inputs within time 

(d) Orange letters indicate wrong inputs within time. 

 

(iii) Which of the following keys are called guide keys on a typewriter? 

(a) F 

(b) A 

(c) ; 

(d) Both (b) and (c) 

 

(iv) Which key combination is used to select text? 

(a) Ctrl+C 

(b) Ctrl+V 

(c) Ctrl+P 

(d) Shift + Arrow keys 

 

(v) Which of the following is called the toggle key? 

(a) Caps Lock 

(b) Num Lock 

(c) Scroll Lock 

(d) All of these 

 

(vi) You inserted an image into your presentation and want to adjust its appearance. Which 

of the following actions is part of image formatting? 

(a) Inserting a new slide 

(b) Adding slide transitions 

(c) Moving, resizing, or rotating the image 

(d) Changing the slide layout 
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4. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) What is the overall term for creating, editing, formatting, storing, retrieving and printing a 

text document? 

(a) Word processing 

(b) Spreadsheet design 

(c) Web design 

(d) Database management 

 

(ii) To check the grammar we should go to which of the following menus? 

(a) Tools Menu 

(b) Insert Menu 

(c) View Menu 

(d) Edit Menu 

 

(iii) Keyboard shortcut to italicise the selected text is 

(a) Ctrl+U 

(b) Shift +U 

(c) Ctrl+I 

(d) Shift + I 

 

(iv) Footer text printed at the …………. of each page of a document. 

(a) Top 

(b) Bottom 

(c) Middle 

(d) None of these 

 

(v) Customizing a document to fit the user’s needs using specific changes to the document 

is called ? 

(a) Formatting 

(b) Customizing 

(c) Styling 

(d) Reloading 

 

(vi) By which menu, you can create blank presentation? 

(a) View 

(b) File 

(c) Insert 

(d) Format 

 

5. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) The another name for the XY chart is 

(a) Column chart 

(b) Net chart 

(c) Bar chart 

(d) Scatter chart 
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(ii) A worksheet is a 

(a) collection of workbooks 

(b) processing software 

(c) combination of rows and columns 

(d) None of the above 

 

(iii) For selecting the entire worksheet in Calc, you need to press. 

(a) Alt + Shift + Spacebar 

(b) Ctrl+ Shift + Spacebar 

(c) Shift + Spacebar 

(d) None of these 

 

(iv) A cell range always has the ……… symbol between the cell references. 

(a) ; (semicolon) 

(b) . (full stop) 

(c) , (comma) 

(d) : (colon) 

 

(v) The cell in a spreadsheet that is in use is called? 

(a) Formula cell 

(b) Main cell 

(c) Active cell 

(d) Header cell 

 

(vi) Which of the following features is used to create a new slide show with the current slides 

but presented in a different order ? 

(a) Rehearsal 

(b) Custom Slide Show 

(c) Slide Show Setup 

(d) Slide Show view 

 

Section B: Subjective Type Questions 

Answer any 3 out of the given 5 questions on Employability skills in 20-30 words 

each.            (2×3=6) 

6. Write down the different types of verbal communication. Give an example for each type. 

7. Write a short note on the factors influencing self management. 

8. Write two advantages of using ICT in workplaces. 

9. Gulab lives in a small village in Rajasthan. She noticed that all the women in her village 

were good at making paintings and handicraft products. She collected money and started a 

business. Gulab would help the women to get material from cities and support them in 

making latest designs. She would then arrange for these paintings and handicraft products 

to be sold in big cities. How do you think Gulab, is helping her society as an entrepreneur? 

10. What is the purpose of soil conservation? 

 

Answer any 4 out of the given 6 questions in 20-30 words each.   (2×4=8) 

11. Which softwares are used in digital communication? 
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12. Differentiate between Home key and Guide key. 

13. Compare the features of manual typewriter, electronic typewriter and Word processing 

software. 

14. What is the use of the Formula Bar? 

15. Can you include more than one mathematical operators in a formula? 

16. How will you add the slide number at the bottom of each slide? 

 

Answer any 3 out of the given 5 questions in 50-80 words each.   (4×3=12) 

17. Write about any five machines that are used in diagnosis. 

18. Write the steps to interpret your results in Rapidtyping software. 

19. What is the need to modify the spacing of the lines or paragraphs of your text? 

20. Define the following terms 

(i) row and column range 

(ii) Active cell in worksheet 

 

21. Describe the workspace views in detail. 
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Information Technology for Class IX-Set 6 

Time : 2 Hrs         Max. Marks : 50 

General Instructions 

• Please read the instructions carefully. 

• This Question paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions, whereas Section B contains Subjective 

Type Questions. 

• Out of the given (5+16)=21 questions, a candidate has to answer (5+10)=15 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• There is no negative marking. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

• Section B Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

Section A: Objective Type Questions [24 Marks] 

1. Answer any 4 out of the given 6 questions on Employability Skills.  (1×4=4) 

(i) Which of the following options describes the purposes that communication can serve in 

our daily lives? 

(a) Inform (tell someone about something) 

(b) Influence (get someone to do something you want) 

(c) Share thoughts, ideas, feelings 

(d) All of the above 

 

(ii) What steps should one take to build confidence? 

(a) Set goals in life and always think positively 

(b) Appreciate oneself for all the achievements. 

(c) Talk to people who are confident. 

(d) All of the above 

 

(iii) You notice that one of your classmates is feeling upset and not participating in the group 

activity. How would you use your self-management skills to handle this situation and also 

help them? 

(a) Ignore them and continue your work without saying anything. 

(b) Gently ask if they are okay and encourage them to join the activity. 

(c) Scold them for not contributing and tell them to participate. 

(d) Tell the teacher to remove them from the group. 

 

(iv) What is a short-range wireless communication technology called? 

(a) Wi-Fi 

(b) Internet 

(c) Bluetooth 
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(d) PS 

 

(v) Businesses cater to the need of the 

(a) area 

(b) society 

(c) market 

(d) village 

 

(vi) Which of the following is an example of renewable resources? 

(a) Coal 

(b) CNG 

(c) Solar Energy 

(d) Petroleum 

 

2. Answer any 5 out of the given 6 questions:      (1×5=5) 

(i) An architect uses special software to design the plan of a building on a computer, which 

shows walls, windows, and rooms in 3D. Which IT-ITeS service is this an example of? 

(a) Data entry 

(b) CAD (Computer-Aided Design) 

(c) Teaching 

(d) Call center 

 

(ii) What is the full form of BPM? 

(a) Business Process Manage 

(b) Business Process Manager 

(c) Business Process Management 

(d) Business Protocol Management 

 

(iii) Rita attends her school classes using a computer and internet connection from her 

home. This is an example of: 

(a) Online learning / e-Education 

(b) Entertainment 

(c) Online shopping 

(d) Bill payment 

 

(iv) Product with embedded software is/are 

(a) Refrigerator 

(b) Washing Machines 

(c) Microwave 

(d) All of these 

 

(v) Which of the following is/are example of BPO services? 

(a) Legal Services and Content Writing 

(b) Software Testing Services 

(c) Financial and Accounting Services 

(d) All of the above 
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(vi) Which view is generally used for creating formatting and designing slides? 

(a) Normal view 

(b) Outline view 

(c) Notes 

(d) Slide Sorter view 

 

3. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) Which of the following is a type of keyboard? 

(a) QWERTY 

(b) DVORAK 

(c) AZERTY 

(d) All of these 

 

(ii) Which of the following is not a key for punctuation marks? 

(a) Comma (,) 

(b) Period (.) 

(c) Semicolon (;) 

(d) Equal Sign(-) 

 

(iii) Which shortkey is used to see WPM speed? 

(a) Ctrl+1 

(b) Ctrl+3 

(c) Alt+2 

(d) Ctrl+2 

 

(iv) Which of the following key is used to deletes the character just to the left of the cursor? 

(a) Backspace 

(b) Esc 

(c) Delete 

(d) Alt 

 

(v) We use which of the following keys to type characters in uppercase letters? 

(a) Shift key 

(b) Caps Lock key 

(c) Backspace key 

(d) Both (a) and (b) 

 

(vi) Which of the following option is not available on Presentation Wizard? 

(a) Empty Presentation 

(b) Form template 

(c) Open New Presentation 

(d) Open existing presentation 

 

4. Answer any 5 out of the given 6 questions      (1×5=5) 

(i) The most widely used Word processing software in late 1970s was …………. 

(a) WordPerfect 

(b) Word 
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(c) WordStar 

(d) Writer 

 

(ii) In a situation where you accidentally undo an action while working on a document, which 

keyboard shortcut would you use to redo it and continue your work smoothly? 

(a) Ctrl+R 

(b) Ctrl+Y 

(c) Ctrl+X 

(d) Ctrl+Z 

 

(iii) Which toolbar is used to perform cut, copy, paste, undo and redo operations? 

(a) Standard toolbar 

(b) Formatting toolbar 

(c) Sidebar 

(d) None of the above 

 

(iv) What is the shape of the mouse pointer when drawing a table? 

(a) Pencil 

(b)White Pointing arrow 

(c) Black Pointing arrow 

(d) Black Plus 

 

(v) To copy the selected text and put it into clipboard, use 

(a) Copy command from Edit tab 

(b) Ctrl+C 

(c) Mouse right click and select Copy option 

(d) All of the above 

 

(vi) Which view button listed below is not one of those available in the workspace? 

(a) Normal View 

(b) Outline view 

(c) Thumbnail view 

(d) Notes 

 

5. Answer any 5 out of the given 6 questions:      (1×5=5) 

(i) You can insert a new sheet in a workbook by clicking the …………. sign at the bottom. 

(a) – 

(b) x 

(c) + 

(d) ÷ 

 

(ii) The sample of a Calc worksheet on the screen can be seen by 

(a) Print preview 

(b) Print 

(c) Review 

(d) None of the above 
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(iii) What will be the result of the formula = COUNT (B1: B3)? where B1=5, B2=4, B3=6 

(a) 15 

(b) 3 

(c) 4 

(d) 5 

 

(iv) How many types of cell references in LibreOffice Calc? 

(a) 1 

(b) 2 

(c) 3 

(d) 4 

 

(v) By using ………… we can add notes to a slide. 

(a) Normal view 

(b) Outline view 

(c) Notes view 

(d) Slide sorter view 

 

(vi) Which shortcut key is used to ungroup the objects? 

(a) Ctrl + Shift + G 

(b) Ctrl + Alt + Shift + G 

(c) Alt + Shift + G 

(d) None of these 

 

Section B: Subjective Type Questions [26 Marks] 

Answer any 3 out of the given 5 questions on Employability skills in 20-30 words 

each.            (2×3=6) 

6. Write down the seven factors affecting perspectives in communication. 

7. What are the factors that affect self-confidence? 

8. Write any four examples of IT-enabled services and describe any two in detail. 

9. List any two comparisons of activities between entrepreneurship and employment. 

10. What is sustainable development? Mention two strategies of sustainable development. 

 

Answer any 4 out of the given 6 questions in 20-30 words each.   (2×4=8) 

11. What are the uses of IT at workplace? 

12. Explain the allocation of keys to fingers on the upper row. 

13. What is the default extension assigned to the document in Writer when you save it? 

Write down the steps to save the document to Microsoft word document? 

14. Define the meaning of formula. 

15. Explain any two operations performed on data in a spreadsheet. 

16. How will you add the name of the company on the top of the each slide? 

 

Answer any 3 out of the given 5 in 50-80 words each.     (4×3=12) 

17. Describe the examples of use of IT in education. 

18. Write some of the factors which are included in typing ergonomics. 
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19. Explain superscript or subscript. 

20. What is spreadsheet? Also define its menu bar. 

21. Explain the characteristics of good quality presentation. 
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Information Technology for Class IX-Set 7 

Time : 2 Hrs          Max. Marks : 50 

General Instructions 

• Please read the instructions carefully. 

• This Question paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions, whereas Section B contains Subjective 

Type Questions. 

• Out of the given (5+16)=21 questions, a candidate has to answer (5+10)=15 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• There is no negative marking. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

• Section B Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

Section A: Objective Type Questions [24 Marks] 

1. Answer any 4 out of the given 6 questions on Employability Skills.  (1×4=4) 

(i) Riya is speaking to her teacher but often looks away and fidgets. What non-verbal 

communication skill should she improve? 

(a) Vocabulary 

(b) Active listening 

(c) Body language 

(d) Speaking fluently 

 

(ii) Grooming is a term associated with 

(a) Time management 

(b) problem solving 

(c) neat and clean appearance 

(d) self-management. 

 

(iii) You are tasked with navigating to a remote location for a field assignment. To determine 

your exact position and ensure accurate travel directions, which technology would you most 

likely rely on? 

(a) Global Positioning System 

(b) Global Payment System 

(c) Global Program System 

(d) Global Pointing System 

 

(iv) During exam week, Ananya is overwhelmed with stress and starts panicking. Which 

strategy would best help her manage this? 

(a) Ignore the exams 
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(b) Practice relaxation and time management 

(c) Skip studying altogether 

(d) Compare marks with friends 

 

(v) Business is a (an) ……… activity. 

(a) social 

(b) economic 

(c) hazardous 

(d) selling 

 

(vi) A steel factory burns firewood and charcoal for heating and melting the steel? What are 

the possible effects on the environment? 

(a) Increase in global temperature 

(b) Decrease in global temperature 

(c) Increase in water pollution 

(d) Decrease in air pollution 

 

2. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) ITeS offers different service(s) 

(a) medical transcription 

(b) data warehousing 

(c) IT help desk service 

(d) All of the above 

 

(ii) A software company needs to train new employees quickly. Which IT-enabled method is 

most efficient? 

(a) Outdoor workshop 

(b) Printed manual only 

(c) Online training modules with assessments 

(d) Verbal instructions 

 

(iii) What is the full form of ITeS. 

(a) Information Technology Service. 

(b) Information Transmission Service 

(c) Information Technology enabled Service 

(d) Information Technology enabled Server 

 

(iv) Information Technology which enables the business by improving the quality of service is 

………. 

(a) IT 

(b) ITeS 

(c) ICT 

(d) None of these 

 

(v) A company outsources its customer service to another country to reduce cost. This is an 

example of- 

(a) E-Commerce 
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(b) Web Designing 

(c) BPO (Business Process Outsourcing) 

(d) IT Hardware Management 

 

(vi) Priya is creating a presentation on “Healthy Food” using Impress. She wants to highlight 

the title. Which of the following features should she use? 

(a) Spellcheck 

(b) Format → Font Size and Bold 

(c) Insert Table 

(d) Slide Transition 

 

3. Answer any 5 out of the given 6 questions      (1×5=5) 

(i) Which of the following is not an arrow key? 

(a) Top (∧) 

(b) Down (↓) 

(c) Right (→) 

(d) Left ( ←) 

 

(ii) The lesson control panel can be used for 

(a) animation 

(b) enable/disable sounds 

(c) plain 

(d) background 

 

(iii) Which of the following mouse pointer can be seen when you are about to type text? 

 
(c) I 

(d) None of these 

 

(iv) Which of the following key consist of digits and mathematical operators? 

(a) Alphanumeric key 

(b) Cursor control key 

(c) Numeric key 

(d) None of the above 

 

(v) …… is a method of typewriting without using the sense of sight to find the keys. 

(a) Touch Method 

(b) See Method 

(c) Dragging Method 

(d) Feel Method 

 

(vi) The slide show can be exited at any time during the slide show by pressing which of the 

following keys? 

(a) Space bar 

(b) End key 

(c) Break key 
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(d) Esc key 

 

4. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) Which of the following is not a component of LibreOffice? 

(a) Writer 

(b) Impress 

(c) Internet Explorer 

(d) Base 

 

(ii) To replace a word Bombay with Mumbai, we should go to which of the following menus? 

(a) Tools Menu 

(b) Edit Menu 

(c) View Menu 

(d) Language Menu 

 

(iii) Header and footer options available in which of the following menus? 

(a) Home menu 

(b) Insert menu 

(c) File menu 

(d) View menu 

 

(iv) Which of the following menus we should go to close an opened document? 

(a) Insert menu 

(b) Edit menu 

(c) File menu 

(d) Home menu 

 

(v) By triple click technique, we can select a ………… 

(a) Word 

(b) Sentence 

(c) Column 

(d) Document 

 

(vi) If you want to apply the same animation effect to all bullet points in a slide, what should 

you use? 

(a) Custom Animation 

(b) Master Slide 

(c) Background Fill 

(d) Hyperlink 

 

5. Answer any 5 out of the given 6 questions.      (1×5=5) 

(i) Calc is the spreadsheet application of …………. suite. 

(a) Libre Office 

(b) Microsoft Office 

(c) Open Office 

(d) Both (a) and (c) 
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(ii) When we select multiple columns in a spreadsheet it is called ………… 

(a) Cell range 

(b) Column range 

(c) Row range 

(d) None of these 

 

(iii) Spreadsheet is used for 

(a) Creating data reports 

(b) Data analysis 

(c) Managing financial and accounting documents 

(d) All of the above 

 

(iv) Which of the following type of package does Calc refer to ? 

(a) Spreadsheet 

(b) Double sheet 

(c) Multi-sheet 

(d) Cannot determine 

 

(v) Which of the following technique can be used to allow only date value in cell? 

(a) Data formatting 

(b) Data sorting 

(c) Data filtering 

(d) Data validation 

 

(vi) Which of the following component contains the name of presentation file? 

(a) Tool bar 

(b) Title bar 

(c) Menu bar 

(d) Status bar 

 

Section B: Subjective Type Questions [26 Marks] 

Answer any 3 out of the given 5 questions on Employability Skills in 20-30 words 

each.            (2×3=6) 

6. Write one sentence of each type – Statement, question, exclamatory and order. 

7. List three things you will do for personal hygiene in each of care, wash and avoid to keep 

clean. 

8. Define the following. 

(i) Wi-Fi 

(ii) Chargeable battery 

 

9. What is the meaning of manufacturing and trading based business? 

10. Write any three actions which you can take to conserve energy. 

 

Answer any 4 out of the given 6 questions in 20-30 words each.   (2×4=8) 

11. What skills are required to work in the IT & ITeS industry? Mention any two. 

 



Information Technology Class IX Sample Papers - Page 41 of 41 
 

12. What do you understand by Guide keys? Name the Guide keys of a 

(a) computer keyboard 

(b) typewriter 

 

13. Write difference between a text editor and a Word processor software. Write the name of 

any text editor or Word processor available in market. 

14. What is the difference between spreadsheet and worksheet? 

15. Explain the advantages of drawing a chart in Calc. 

16. What objects can be inserted to slides in Impress? 

 

Answer any 3 out of the given 5 questions in 50-80 words.   (4×3=12) 

17. What is BPM industry? Also, explain the structure of the IT-BPM industry. 

18. Discuss the rules of touch typing. 

19. Do you think, use of bulleted lists or numbered lists is more appropriate in a Writer 

document? 

20. Explain the concept of cell referencing along with its various types. 

21. How will you insert and delete the slide in presentation? 
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SAINIK SCHOOL IMPHAL 

WINTER VACATION HOMEWORK/ASSIGNMENT FOR CLASS IX: 2025-26 

SUBJECT: INFORMATION TECHNOLOGY (402) 

 
(To be done in A4 size paper) 

Write an assignment on the various IT applications. The following IT Applications 

should be included. 

− IT in home computing 

− IT in everyday life 

− IT in library 

− IT at workplace 

− IT in education 

− IT in entertainment 

− IT in communication 

− IT in business 

− IT in science and engineering 

− IT in banking 

− IT in insurance 

− IT in marketing 

− IT in health care 

− IT in the government and public service 

The sequence of the assignment should be as follows:  

− Cover Page  

− Contents  

− Introduction  

− Explaining the various topics  
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Details are given below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

“IT Applications” 

An assignment submitted  

for Annual Examination: 2025-26 

 

 

 

 

Submitted By:  Submitted To: 

Cdt ….   Sir Tiken 

Adm No ….  TGT Computer Science 

Class… Section … 

 

 

 

 

 

 

 

 

 

 

SAINIK SCHOOL IMPHAL 

Cover Page 2nd Page 

 

Contents 

 

    Page No 

Introduction    1 

IT in home computing   2 

IT in everyday life   3 

IT in library    4 

IT at workplace    5 

IT in education    6 

IT in entertainment   7 

IT in communication   8 

IT in business    9 

IT in science and engineering  10 

IT in banking    11 

IT in insurance    12 

IT in marketing    13 

IT in health care    14 

IT in the government and public service  15

  

 

Introduction 

 

(Explain the concept of IT) 

Introduction 

 

IT in home computing 

 

(Explain the topic) 
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IT in everyday life 

 

(Explain the topic) 

 

IT in library 

 

(Explain the topic) 

 

IT at workplace 

 

(Explain the topic) 

 

IT in education 

 

(Explain the topic) 
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IT in entertainment 

 

(Explain the topic) 

 

IT in communication 

 

(Explain the topic) 

 

IT in business 

 

(Explain the topic) 

 

IT in science and 

engineering 

 

(Explain the topic) 
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IT in banking 

 

(Explain the topic) 

 

IT in insurance 

 

(Explain the topic) 

 

IT in marketing 

 

(Explain the topic) 

 

IT in health care 

 

(Explain the topic) 
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IT in the government and 

public service 

 

(Explain the topic) 
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Class 9 hindi  
winter Vacation Home Work (2025-2026) 

 

Subject Teacher: Dr N Gunachandra Singh TGT-HINDI 

  
 

निरे्दश /Instruction — 

      दर्दए गए पाठ्य-सामग्रियों का प्रयोग आगामी परीक्षा में ककया जाएगा। इसलिए दर्दए गए सामग्रियों की 
अच्छी तरह तैयारी करें। दर्दए गए अिुच्छेर्दों में से ककसी एक विषय का चयि करें  और उस चयनित विषय 
पर अिुच्छेर्द लिखकर अिकाश (िेकेशि) से आते समय जमा करें। यह यार्द रहे कक आपके द्िारा चयनित 
विषय पर मौखखक परीक्षा (Oral Test) िी जाएगी, इसलिए अपिे चयनित विषय को अच्छी तरह कंठस्थ 
करें। 

        The given study materials will be used in the upcoming examination, so prepare them 
thoroughly. Select any one topic from the given paragraphs and write a paragraph on the 
selected topic. Submit it when you return from vacation. Please note that an oral test will be 
conducted on the topic selected by you, so memorize your chosen topic properly. 

➢ 1. किसी एि विषय पर दिए गए संिेत ब िंओुं िे आधार पर लगभग 120 शब् िों में अनुच् छेि ललखिए          
  

ि) सोशल मीडिया और युिा  
संिेत ब िं-ु  

• सोशल मीडिया और युिा से अलभप्राय  
• निारात् मि प्रभाि  
• युिा िगग िे आिषगण िा िारण  

ि) पयाािरण संरक्षण और युिा 
 संिेत ब िं-ु 

• पयागिरण संरक्षण िा अर्ग 
• युिाओं िी भूलमिा 
• भविष्य िे ललए महत्ि 

2. अथा की दृष्टि से िाक् य भेर्द  

3. उपसगा एिं प्रत् यय  

4. संग्रि 
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MANIPURI 



Winter vacation home work for class-ix 

Subject:Manipuri 

1.nhaQ mutuM caUbni haIn KLlu ॥ diLhid lEb nhaQki mruP ToQcoM dinest 

mnipurd hoHlQlib AIq-Asagi mrMd ciTi Am Iyu ॥ 

2.mKagi paUrOsiH Asi sNdoQn Iyu ॥ 

   a)KujaI mpun fadoQ taI ॥ 

  b)liNn mKuN cqlMdaId cuMI ॥ 

  c)hOdoH tumiN lEbn cfu ZMI ॥ 

  d)fYtb migi hidaQ lEte ॥ 

  e) KoH coYlg ciN coYli ॥ 
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Class :9 

Winter vacation Assignment: Maths   

 

Q1. Prove that the line segment joining  the mid points of two sides of a triangle is 

parallel to the third side. 

Q2.If the diagonals of a parallelogram are equal  then show that it is a rectangle. 

Q3.Prove that equal chords of a circle subtend equal angles at the centre. 

Q4. Prove that the angle subtended by an arc  at the centre is double the angle 

subtended by it at any point on the remaining part of the circle.  

Q5.Solve all the textual questions on the chapter of surface areas , volumes of sphere 

and cone. 

http://q2.if/
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SOCIAL SCIENCE 
(History/ Economics) 



Winter Vacation Assignment 

Class: IX      Subject: Social Science (History/ Economics) 

 

1. On an outline map of France locate and label 

i. Bordeaux 

ii. Nantes 

iii. Paris 

iv. Marseille 

2. On an outline map of world locate and label major countries of World War-I 

i. Central Powers: Germany, Austria-Hungary, Turkey 

ii. Allied Powers: France, England, Russia and U.S.A 

 

3. Case-Based Study: Poverty as a Persistent Economic and Social Challenge 

Despite decades of planned economic development, poverty continues to remain one of the 

most pressing challenges in India. Poverty is not merely the absence of income; it is a 

condition characterised by hunger, malnutrition, lack of access to education and healthcare, 

unemployment, social exclusion, and insecurity. For millions of people, poverty 

determines not only their living conditions but also their life opportunities. 

 

In rural areas, poverty is often linked to landlessness, low agricultural productivity, 

dependence on monsoon rainfall, and seasonal unemployment. Small and marginal farmers 

frequently borrow money from informal sources to meet basic needs or invest in farming. 

Crop failure, illness, or natural disasters can easily push such households deeper into 

poverty. Agricultural labourers and migrant workers face uncertain employment and low 

wages, making it difficult to escape the cycle of deprivation. 

 

Urban poverty presents a different but equally complex picture. Large numbers of people 

migrate to cities in search of better livelihoods, only to find employment in the informal 

sector as construction workers, street vendors, domestic helpers, or factory labourers. 

These workers often live in overcrowded slums with inadequate sanitation, unsafe drinking 

water, and limited access to public services. The absence of job security and social 

protection makes urban poor highly vulnerable to economic shocks such as inflation, job 

loss, or health emergencies. 

 

Poverty in India is also closely connected to social factors such as caste, gender, and 

regional disparities. Historically marginalised communities like Scheduled Castes and 

Scheduled Tribes experience higher levels of poverty due to discrimination, limited access 

to resources, and low educational attainment. Women, particularly in poor households, face 

unequal access to nutrition, healthcare, and education, further reinforcing inter-

generational poverty. 



 

Recognising the multi-dimensional nature of poverty, the government has introduced 

various poverty alleviation programmes. These include employment generation schemes, 

subsidised food distribution, housing programmes, and initiatives to promote education 

and skill development. While these programmes have helped reduce poverty levels over 

time, challenges such as improper implementation, lack of awareness, and exclusion of 

deserving beneficiaries persist. 

 

Thus, poverty remains not only an economic problem but a social and structural challenge 

that requires long-term, inclusive, and sustainable solutions. 

 

i. Analyse poverty as a multi-dimensional problem rather than only an income-related 

issue. Use examples from the case study to support your answer. 5 marks 

 

ii. Compare the nature and causes of poverty in rural and urban areas of India. Why 

do strategies to reduce poverty need to differ for these two contexts?  

         5 marks 

iii. Evaluate the effectiveness of poverty alleviation programmes in addressing 

structural causes of poverty. Suggest measures to make these programmes more 

inclusive and sustainable.      5 marks 

 

4. Case-Based Study: Food Security in India 

India produces a large quantity of food grains every year, yet millions of people still face 

hunger and malnutrition. Ensuring that all citizens have access to sufficient, safe, and 

nutritious food at all times is referred to as food security. Achieving this goal remains a 

significant challenge due to a combination of social, economic, and administrative factors. 

 

Ramesh, a farmer from a small village in Uttar Pradesh, grows wheat and rice on his modest 

land. While his own family has enough to eat, many landless labourers in his village 

struggle to secure adequate food. During the lean agricultural season, these workers depend 

on daily wages to buy food from local markets. When employment is uncertain, their food 

intake becomes irregular, leading to malnutrition, especially among children and women. 

In urban areas, migrant workers face a similar problem; they live in congested slums with 

limited access to affordable, quality food. 

 

The Indian government has recognised the need for ensuring food security through policies 

such as the Public Distribution System (PDS), which provides subsidised grains to poor 

families, and welfare programmes like Mid-Day Meal Scheme, Integrated Child 

Development Services (ICDS), and the National Food Security Act (NFSA) of 2013. These 

programmes aim to guarantee minimum food requirements for vulnerable groups. 

However, their implementation faces challenges. Leakage of grains, corruption, inaccurate 



targeting of beneficiaries, and poor infrastructure often prevent food from reaching the 

intended people. 

 

In addition, food security is affected by environmental and economic factors. Droughts, 

floods, and soil degradation reduce crop yields, while inflation increases the price of 

essential food items, making it unaffordable for the poor. Unequal distribution of resources 

such as land and water also limits production and access. In this context, sustainable 

agricultural practices, modern storage facilities, and efficient supply chains become 

essential components of food security. 

 

Furthermore, food security is not only about calories but also nutrition. Many people may 

get enough food to eat but still suffer from hidden hunger, a deficiency of essential vitamins 

and minerals. Policies must therefore address both quantity and quality of food. Civil 

society initiatives, community kitchens, and nutrition awareness programmes complement 

government efforts to ensure that food security translates into actual health benefits. 

 

India’s experience demonstrates that food security is a multi-dimensional challenge. It 

involves production, distribution, affordability, nutrition, and sustainability. Tackling it 

requires coordinated efforts from governments, farmers, communities, and individuals, 

along with strong monitoring and accountability mechanisms to ensure that policies reach 

the most vulnerable. 

 

i. Analyse the concept of food security in India. Why is it considered a multi-

dimensional challenge rather than just a matter of food production?   

         5 marks 

ii. Examine the role of government programmes like the Public Distribution System 

(PDS) and the National Food Security Act in addressing food insecurity. What 

limitations do these programmes face?    5 marks 

iii. Suggest measures that can improve food security in India, focusing on production, 

distribution, nutrition, and sustainability. Justify your suggestions with examples. 

         5 marks 
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ENGLISH ASSIGNMENTS 
CLASS IX 

 
1. Project Work (Choose ANY ONE) 
 
Project 1: Reading Portfolio 
Choose one story/poem from your textbook. Prepare a portfolio including: 

a) Summary (150–180 words) 
b) Themes 
c) Character notes 
d) Vocabulary (30–40 words with meanings) 
e) Personal response (What you learned) 

 
Project 2: Report Compilation 
Prepare a report on any event in your school (Sports Meet, Cleanliness Drive, Cultural 
Day) in 120 words. 
 
Project 3: Grammar  
Write 10 rules of each topic of grammar in your English syllabus with examples. 
 
2. Creative Writing Assignment 
 

a) Story Writing 
 

Begin with: 
“As I opened the old cupboard, something unusual caught my eye…” 
Write a story in 150–180 words. 

 
b. Descriptive Paragraph 

 
Describe “A place in school that inspires me.” (120 lines) 

 
3. Character Sketch (Any Textbook Lesson) 
 
Write a 100–120 word character sketch of any ONE from your English textbook: 
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Geography Winter vacation assignments 

Class 9 

1. Describe any three features of tropical evergreen forests. 

2. Explain any three measures taken for the conservation of forests and wildlife in 

India. 

3. What is natural vegetation? Explain any two factors that influence the distribution  

of natural vegetation in India. 


